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1. PREFACE 

 
This manual will guide you through the installation and operation of the ETL 

MC68HC908AZ60 Programmer Serial Port Version, referenced hereafter as the HC08-
Programmer. 

The HC08-Programmer has been designed for Reading, Programming of FLASH, ROM, 
EEPROM contents of the next Motorola Microcontroller Unit (MCU): 

 
 MC68HC908AZ60 (2J74Y)    MC68HC05H12 (0H57A) 
 MC68HC908AZ60 (4J74Y)    MC68HC08AB16A (0L72A) 
 XC68HC908AZ60 (8H62A)* 
 MC68HC908AZ60A (3K85K) 
 MC68HC908AS60 (3J74Y) 
 MC68HC908AS60A (1L87J) 
 MC68HC908AB32 (3K56G) 
 MC68HC08AZ60 (1J35D) 
 MC68HC08AZ32 (0J66D) 
 MC68HC08AZ32 (1H56A) 
 MC68HC08AS20 (0H94K) 
 MC68HC08AZ32A (1L52H) 

Note: Most number of devices can be programmed in two operating modes In-
Circuit and On-Board. 

 
For full information about HC08-Programmer features 

 
ove in list can’t be guaranteed of correct 

rammer. 

see Appendix Table 8. 

Note: XC68HC908AZ60 device memory allocation and monitor ROM similar 
to MC68HC908AS60 (3J74Y). 

 Note: Devices that not mentioned ab
reading, programming by HC08-Prog

 
2. CHECKLIST AND REQUIREMENTS 

 
The e supplied with the HC08-Programmer and the 
system

 
  Optional Extra

 following describes what items ar
 requirements if used by a PC. 

 HC08-Programmer – supplied 
 Two QFP64 Adaptors – supplied 
 One QFP100 Adaptor – supplied 
 One PLCC52 Adaptor – supplied 

Cable -A DB9 “straight-thru” cable – supplied 
on CD-ROM –HC08-Programmer PC software  

 

 Pow

 

 
…9) Desktop PC and a free Serial Port (COM1

 Memory - Minimum 32 Mbytes 
 Display - Color SVGA display recommended 
 Preinstalled DWG Viewer 3.0 software* 

er supply 12 Volt/500 mA linear power supply source 
Win2000, WinXP)  OS -MS-Windows (Win98, 

Note: Free DWG Viewer 3.0 software can be downloaded 
from http://www.etlweb.net/files/viewers/dwgviewer.zip 
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3. INSTALLATION AND USE 
 

8 ED’s and three mode jumper (Figure 1).  
ED 3). 

 

The HC0 -Programmer includes three L
Color L ’s indicates programmer state and external power supply voltage (Table 1, 2, 

GREEN External Power supply OK. 
RED ply voltage or voltage on IRQ pin, 2 pin Motorola device 

 9.5 Volt (see Figure1). 
External Power sup
socket and IRQ pin on CNT1 connector, lower than

ORANGE Voltage +5V sup t 22, 55 pins and to CNT1 Vcc 
pin (see Figure1). 

plied to Motorola device socke

DA ltage o than 6 Volt. RK Vo n HC08-Programmer lowers 
Table 1. LED1 color meaning 

 
GREEN HC08-Programmer is ready. 

GREEN Flashing HC08-Programmer is busy. 
RED Error occurred while operation. 

Table 2. LED2 color meaning 
 

DARK ode or built-in +5V Voltage regulator damaged or logic levels on 
PTC0, PTC1, PT
Standby m

C3 pins not correct. 
ORANGE Built-in +5V Voltage regulator OK and logic levels on PTC0, PTC1, PTC3 

pins OK. 
Table 3. LED3 color meaning 

1  Table 4). JP2 and 
JP3 reserved fo f

 

 
Jumper-1 (JP ) is intended for HC08-Programmer mode selection (see

uture use. r 

JP1
JP2
JP3JP1  

Normal operation. Motorola device EEPROM/FLASH 
Reading/Programming. 

 
Service mode. HC08-Programmer firmware update. JP1

JP2
JP3

Table 4. HC08-Programmer operation modes 
 

 Note: When Service mode selected LED1 and LED2 will be RED. 
 

LED1 LED2 LED3

JP1
JP2
JP3

C
O

M
 P

o
rt 

C
on

ne
ct

or

1 pin-key

Motorola device socket for
On-Board programming

Connector
for In-Circuit 
Programming

Additional
connector
for In-Circuit
Programming

PTA0 GND

GND

IRQ

RES

VCC

PTC1

PTC0

OSC1

PTC3

HIGH1

GND

Power supply
connector 12 V

 
Figure 1. The HC08-Programmer board layout 
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3.1 PROGRAMMER CHECK AND CONNECTION TO PC 

 
 Connect the power supply source to HC08-Programmer (an external 12 V DC power 

supply source is required). 
 Attach a serial cable to the 9-pin connector on the programmer and to a COM port on 

the PC. 
 Insert jumper JP1 (see Figure 1). 
 Remove any adaptor from Motorola device socket and any wire bus from CNT1,2. 
 Turn On power supply source and make sure that LED1 appear green. See Table1 for 

LED1 condition. 
 Start HC08-Programmer software. 
 After few seconds you should see on display message: “MC68HC908AZ60 

Programmer Ver-X.X detected”. 
 In case when you should see message: “MC68HC908AZ60 Programmer Ver-X.X not 

found”, change COM port number and baud rate settings. To do that select “Tools” 
menu item and than select “Port Options”. Set new COM port options. After pressing 
“OK” button the new setting will be applied and software reattempts connection with 
programmer. 

 Now HC08-Programmer ready to operate. 
 

 Note: Update HC08-Programmer firmware if required (see Section 3.2). 
 

3.2 PROGRAMMER FIRMWARE UPDATE 
 

Thi e firmware (ATMEGA16) of HC08-Programmer. 

rom CNT1,2. 
hat LED1 and LED2 appear red. 

 0 Programmer Ver-X.X detected” and 

date firmware. 

 ware update completed, turn off power supply, close HC08-Programmer 

 w firmware version “MC68HC908AZ60 
Programmer Ver-X.X detected” will appear. 

 

s section describes how to updat
 Remove JP1 (see Figure1). 
 Remove any adaptor from Motorola device socket and any wire bus f
 Turn On power supply; make sure t
 Start HC08-Programmer software. 

Compare firmware version “MC68HC908AZ6
version specified in “Help>About” menu item. 

 If versions not coincide, follow next steps to up
 Select menu item “Tools>Firmware Update”. 
 After message box “Firmware Update” appeared, press “OK” button. 

After firm
software. 

 Insert JP1. 
 Turn On power supply. Make sure that LED1 appear green. 

Start HC08-Programmer software on PC. Ne

4. INTERFACE TYPES AND OPERATIONAL MODES 
 

r. MON08, Security Sequence Auto Search and Enter Security Sequence modes are 
vailable. 

 

This section describes two interface type and three operational modes of HC08-Programmer. 
In-Circuit Programming and On-Board Programming interfaces are available in HC08-
Programme
a
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4.1 IN-CIRCUIT PROGRAMMING 
 

Generally, In-Circuit programming interface useful for “fast” access to target MCU EEPROM 
resources. In this mode HC08-Programmer automatically detects target MCU bus speed. Ceramic 
resonator connected to target MCU must be in range from 1.6 MHz to 16 MHz. Also pins PTC0, 
PTC1, PTC3 must be correct configured to achieve required MCU bus speed (see Appendix 
Figure3). If the ceramic resonator frequency low than 1.6 MHz, use clock overriding from HC08-
Programmer. On the CNT2 connector, OSC1 pin support external 8MHz clock frequency to target 
MCU. Connect this pin to target MCU OSC1 pin. For circuit stability any components on MCU 
OSC1, OSC2 pins such as capacitors, resistors and crystal resonator must be disconnected. 

Note: Devices MC68HC908AZ60 (4J74Y), MC68HC08AZ60  (1J35D) has 

 Note: Device MC68HC08AZ32A (1L52H) has extended security possibilities, 
ence required. 

modified monitor ROM: On-board programming available only! 

so knowledge of Security Sequ
 

4.2 ON-BOARD PROGRAMMING 
 

On board programming interface type is basic for HC08-Programmer. In this interface type all 
programmer features are available. For example, FLASH reading, programming possible only with 
this interface type. Target MCU must be mounted to the corresponding adaptor QFP64, QFP100 or 
PLCC52 supplied with HC08-Programmer. Regarding of operation mode external 800 KHz or 
8MHz uency 
realized. 

en target adaptor with MCU mounted check contacts careful to avoid 
it. Otherwise HC08-Programmer voltage regulator can be damaged! 

freq supplied to MCU. Also, for Security Sequence passing specific power control 

 Note: Wh
short circu

 
4.3 MON08 MODE 

 
This mode uses standard Motorola 08 Family MCU interface (see Appendix Figure 3). To 

enter this mode, defined conditions must be established. “High” voltage (10V) on IRQ pin, “High” 
level on PTC0 pin and “Low” levels on PTC1, PTC3. The PTA0 pin use for communication with 
host PC. Because of slow speed communication via PTA0 pin, HC08-Programmer realizes 
EEPROM reading, programming only. If In-Circuit programming interface selected, before 
passing Security Sequence HC08-Programmer automatically detects target MCU communication 
speed. After speed founded, standard MON08 protocol is performed. If On-Board programming 

terface selected, communication speed fixed according device type, and MON08 protocoin
p

l is 
e if MCU don’t have additional SCI interface pins (TxD, RxD) or 
e 8 mode is only one way to establish connection with MCU. 
rformed immediately. Also 
se pins are damaged, MON0th

 
4.4 AUTO SS MODE 

 
This mode is main difference from other programmers for 08 Motorola family devices. In this 

mode HC08-Programmer automatically search the Security Sequence and passing it. Than, if 
required, Security Sequence automatically stored in “SSList.txt” file. New, found SS than can be 
used in future in Enter SS mode (see Section 4.5). This mode is useful for reading FLASH contents 
of MCU. Also on some devices such as MC68HC08AZ32A (1L52H) even EEPROM contents 
couldn’t be read without knowledge of Security Sequence. 
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Bec e of u
performed on high

 lectrical current 
noise on Motorola device power pins. So any equipment with high level of 

ic radiation must be switched off. 

 

aus sing additional SCI interface pins (TxD, RxD) reading, writing of MCU 
 speed. 

Note: Security Sequence Auto search based on analyzing of e

electromagnet

Note: Auto SS mode implemented for educational purposes only. 
 

4.5 ENTER SS MODE 
 

This mode implemented for “full” working with all FLASH, ROM, EEPROM areas of MCU. 
Only entering of right Security Sequence will allow user “full” access to MCU resources. Security 
Sequence located from $FFF6 to $FFFD address in memory space of MCU. Every time when host 
PC trying to establish connection with MCU correct Security Sequence must be entered. For work 
facilitation with Security Sequences HC08-Programmer automatically analyze all operations with 
$FF

rectory as HC08-Programmer software. To load SS from file press 
“LoadSS” button, select required Security Sequence and press “OK” button. Also, User can see is 
MC g window. 

ins (TxD, RxD) reading, writing of MCU 
per

F6-$FFFD areas and if required, store new Security Sequence in “SSList.txt” file. This file can 
be found in the same di

U secured or unsecured in HC08-Programmer lo
ecause of using additional SCI interface pB

formed on high speed. 
 

5. WORKING WITH TARGET MCU 
 
This section contains overall information about Motorola MCUs supported by HC08-

Pro ehavior described. 
 installed devices (see Table 8) can be read, program and 

ver

grammer. Also, some device specific b
hen HC08-Programmer successfullyW

ify in corresponding mode. 
 

5.1 CUSTOMARY DEVICES 
 
This ing with next devices: 

 MC68HC908AS60 (3J74Y) 

ll ection 4). 
 

section describes basic rules work
 MC68HC908AZ60 (2J74Y) 
 MC68HC908AZ60A (3K85K) 

 MC68HC908AS60A (1L87J) 
 MC68HC908AB32 (3K56G) 

A  devices can be read, program and verify in all HC08-Programmer modes (see S

5.1.1 In-Circuit EEPROM reading example 
 

Appendix Figure 3). 
ble 1) disconnect any 

on MCU. 
device in HC08-Programmer software (“Device” button). 

 -Programmer software. 

 

 Connect required pins to board with target MCU (see 
 Apply power to HC08-Programmer. If LED1 red (see Ta

components from IRQ pin 
 Select corresponding 
 Select “ICP” and “MON08” mode. 

Select “Read Sequence” panel in HC08
 Press “EEPROM” button. 

Press “Start” button. 
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 After several seconds LED1 on HC08-Programmer became to orange light. That means 
that +5 voltage regulator switched on. 

 levels on PTC0, PTC1, PTC3 pins OK. 
ing completed. Now 

target MCU powered off. 
arily to save memory dump to 

file (see Section 8.2). 

 Also LED3 on HC08-Programmer must light orange. That means that +5 V voltage 
regulator OK and logic

 When LED2 on HC08-Programmer became permanent green, read

 After read sequence successfully completed it is necess

 If some errors appeared during reading process refer to Section 9. 
 

5.1.2 In-Circuit EEPROM programming example 
 

 Connect required pins to board with target MCU (see Appendix Figure 3). 
 Apply power to HC08-Programmer. If LED1 red (see Table 1) disconnect any 

e in HC08-Programmer software (“Device” Button). 
N08” mode. 

 C08-Programmer software. 

 

d on. 
s that +5 V voltage 

regulat
 When d. 

Now ta
 If some r to Section 9. 

ing the EEPROM nonvolatile 
DIV). See Section 6 for details. 

first time, 

components from IRQ pin on MCU. 
 Select corresponding devic
 Select “ICP” and “MO
 Load EEPROM data from file (see Section 8.1) or enter data to Hex Editor. 

Select “Program Sequence” panel in H
 Press “EEPROM” button. 

Press “Start” button. 
 After several seconds LED1 on HC08-Programmer became to orange light. That means 

that +5 voltage regulator switche
 Also LED3 on HC08-Programmer must light orange. That mean

or OK and logic levels on PTC0, PTC1, PTC3 pins OK. 
LED2 on HC08-Programmer became permanent green, programming complete
rget MCU powered off. 
 errors appeared during reading process refe

 Note: Extra care must be taken when programm
registers (EENVR1, EENVR2, EE1DIV, EE2

 ramming, for a Note: Strongly recommended before EEPROM prog
read EEPROM contents and save it to file. 

 
5.1.3 On-Board EEPROM reading example 

 
 Mount target MCU on corresponding QFP64, QFP100 or PLCC52 adaptor.* 

Device Socket on HC08-Programmer in according to 1 pin-

 tware (“Device” Button). 

 

 LED1 on HC08-Programmer became orange light. That means 

 Also LED3 on HC08-Programmer must light orange. That means that +5 V voltage 
regulat

 When  

 Disconnect any wire bus from CNT1 and CNT2 connectors. 
 Insert adaptor to Motorola 

key (see Figure 1). 
 Apply power to HC08-Programmer. 

Select device in HC08-Programmer sof
 Select “OBP” and “MON08” mode. 

Select “Read Sequence” panel in HC08-Programmer software. 
 Press “EEPROM” button. 
 Press “Start” button. 

After several seconds 
that +5 voltage regulator switched on. 

or OK and logic levels on PTC0, PTC1, PTC3 pins OK. 
LED2 on HC08-Programmer became permanent green light, reading completed.
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 read sequence successfully completed it is necessarily to save memory dump to 
e Section 8.2). 

When 
file (se

 If some errors appeared during reading process refer to Section 9. 
 

l to avoid 
maged! 

of programmer and target MCU! 

 Note: When target MCU mounted on adaptor check contacts carefu
ulator can be dashort circuit. Otherwise HC08-Programmer voltage reg

 Note: During removing the adaptor with target MCU HC08-Programmer must 
be powered off to avoid damaging 

 
5.1.4 On-Board EEPROM programming example 

 
adaptor.* 

om CNT1 and CNT2 connectors. 
orola Device Socket on HC08-Programmer in according to 1 pin-

 

 

 ram Sequence” panel in HC08-Programmer software. 

Press “
 After s s 

that +5
 Also L  V voltage 

regulat
 When ng 

comple
 If some r to Section 8. 

tor check contacts careful to avoid 
aged! 

 target MCU! 

 Note: Extra care must be taken when programming the EEPROM nonvolatile 
DIV). See Section 6 for details. 

Note: Strongly recommended before EEPROM programming, for a first time, 

 Mount target MCU on corresponding QFP64, QFP100 or PLCC52 
 Disconnect any wire bus fr
 Insert adaptor to Mot

key (see Figure 1). 
Apply power to HC08-Programmer. 

 Select device in HC08-Programmer software (“Device” Button). 
Select “OBP” and “MON08” mode. 

 Load EEPROM data from file (see Section 8.1) or enter data to Hex Editor. 
Select “Prog

 Press “EEPROM” button. 
 Start” button. 

everal seconds LED1 on HC08-Programmer became orange light. That mean
 voltage regulator switched on. 
ED3 on HC08-Programmer must light orange. That means that +5
or OK and logic levels on PTC0, PTC1, PTC3 pins OK. 
LED2 on HC08-Programmer became permanent green light, programmi
ted. 
 errors appeared during reading process refe

 Note: When target MCU mounted on adap
short circuit. Otherwise HC08-Programmer voltage regulator can be dam

 Note: During removing the adaptor with target MCU HC08-Programmer must 
be powered off to avoid damaging of programmer and

registers (EENVR1, EENVR2, EE1DIV, EE2

 
read EEPROM contents and save it to file. 

 
5.1.5 On-Board FLASH reading, programming 

 
To  unsecured. Device can be unsecured only at On-

Board 
 
 
 

perform this operations device need to be
programming interface. User can unsecure device in three ways: 
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5.1.5.1 Unsecure device using Auto SS mode 
 

 

 
  software (“Device” Button). 

 ral seconds LED1 on HC08-Programmer became orange light. That means 
that +5

 Also L e 
regulat

 Now S ight bottom 
corner indicates completion percent. Usually Auto SS procedure keeps from 5-35 

 value for a long time, procedure must 
be stopped, and reattempted again. 

e add to 

tacts careful to avoid 
C08-Programmer voltage regulator can be damaged! 

er must 
f to avoid damaging of programmer and target MCU! 

 Mount target MCU on corresponding QFP64, QFP100 or PLCC52 adaptor.* 
Disconnect any wire bus from CNT1 and CNT2 connectors. 

 Insert adaptor to Motorola Device Socket on HC08-Programmer in according to 1 pin-
key (see Figure 1). 
Apply power to HC08-Programmer. 
Select device in HC08-Programmer

 Select “OBP” and “ASS” mode. 
Select “Read Sequence” panel in HC08-Programmer  software. 

 Press “Start” button. 
After seve

 voltage regulator switched on. 
ED3 on HC08-Programmer must light orange. That means that +5 V voltag
or OK and logic levels on PTC0, PTC1, PTC3 pins OK. 
ecurity Sequence search operation in progress. Progress bar at the r

minutes. If progress bar indicator doesn’t change

 After procedure successfully completed new Security Sequence will b
“SSList.txt” file and can be used in Enter SS mode. 

 Now FLAH can be read, program in the same manner as EEPROM. See previous 
sections. 

 Note: When target MCU mounted on adaptor check con
short circuit. Otherwise H

 Note: During removing the adaptor with target MCU HC08-Programm
be powered of

 
5.1.5.2 Unsecure device using Enter SS mode 

 
 52 adaptor.* 

 r to Motorola Device Socket on HC08-Programmer in according to 1 pin-

 

 ode. 
Enter c

 Select 
Press “

 After s That means 
that +5

 Also L er must light orange. That means that +5 V voltage 
regulator OK and logic levels on PTC0, PTC1, PTC3 pins OK. 

light, operation 
completed. 

 If message  can be read, 

eading, programming will 
return unexpected results. 

Mount target MCU on corresponding QFP64, QFP100 or PLCC
 Disconnect any wire bus from CNT1 and CNT2 connectors. 

Insert adapto
key (see Figure 1) 
Apply power to HC08-Programmer. 

 Select device in HC08-Programmer software (“Device” Button). 
Select “OBP” and “ESS” m

 orrect Security Sequence or load SS with help of “Load SS” button. 
“Read Sequence” panel in HC08-Programmer software. 

 Start” button. 
everal seconds LED1 on HC08-Programmer became orange light. 
 voltage regulator switched on. 
ED3 on HC08-Programm

 When LED2 on HC08-Programmer became permanent green 

 “Device Unsecured!” appeared in log Window than FLASH
program in the same manner as EEPROM, see previous sections. 

 If “Device Secured!” appeared in log Window than FLASH r
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 Note: When target MCU mounted on adaptor check contacts careful to avoid 
-Programmer voltage regulator can be damaged! 

e adaptor with target MCU HC08-Programmer must 

short circuit. Otherwise HC08

 Note: During removing th
be powered off to avoid damaging of programmer and target MCU! 

 tes equal to FLASH Note: For “new”, erased devices eight Security Sequence by
. erase state (see Table 6)

 
5.1.5.3 Unsecure device using FLASH Erase in Enter SS mode 

 

 52 adaptor.* 
om CNT1 and CNT2 connectors. 

-Programmer software (“Device” Button). 

 t eight values of Security Sequence. These values equal to FLASH Erase 
is values equal to $00. 

 se FLASH” button. 
Press “

 After s s 
that +5

 Also L  V voltage 
regulator OK and logic levels on PTC0, PTC1, PTC3 pins OK. 

 erased. 
mmer. This operation will reset 

l in HC08-Programmer software. 

rammer became permanent green light, operation 

 n adaptor check contacts careful to avoid 
mmer voltage regulator can be damaged! 

WARNING: ALL FLASH CONTENTS WILL BE LOST! 
Mount target MCU on corresponding QFP64, QFP100 or PLCC

 Disconnect any wire bus fr
 Insert adaptor to Motorola Device Socket on HC08-Programmer in according to 1 pin-

key (see Figure 1). 
 Apply power to HC08-Programmer. 
 Select device in HC08
 Select “OBP” and “ESS” mode. 

Enter correc
State (see Table 6). For Example, for MC68HC908AZ60 th

 Select “Program Sequence” panel in HC08-Programmer software. 
Push “Era

 Start” button. 
everal seconds LED1 on HC08-Programmer became orange light. That mean
 voltage regulator switched on. 
ED3 on HC08-Programmer must light orange. That means that +5

 Now FLASH area
 Turn Off and than turn On power on HC08-Progra

device. previous security state of the 
 Select “Read Sequence” pane
 Press “Start” button. 
 When LED2 on HC08-Prog

completed. 
 Message ”Device Unsecured!” will appear in log window. 
 Now FLASH can be read, program in the same manner as EEPROM. See previous 

sections. 

Note: After target MCU mounted o
short circuit. Otherwise HC08-Progra

 Note: During removing the adaptor with target MCU HC08-Programmer must 
be powered off to avoid damaging of programmer and target MCU! 

 
5.2 ROM DEVICES 
This section describes basic rules working with next devices: 

 MC68HC08AZ32 (0J66D) 
 MC68HC08AZ32 (1H56A) 
 MC68HC08AS20 (0H94K) 
 MC68HC08AB16A (0L72A) 
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Program memory of these devices formed while manufacturing of MCU by Motorola. So any 
attempts to reprogram ROM section will be failed. Only EEPROM reading, programming 
ope rk 
wit

ration is available for this type of devices. Working with EEPROM area not differs from wo
h customary devices (see Section 5.1). 
 

5.3 MC68HC908AZ60 4J74Y MASKSET 
 

This section describes the algorithm to work with MC68HC908AZ60 device, 4J74Y maskset. 
The device has non standard security scheme. As against to 08 family devices, security byte 

pla e of this byte equal $D3, the device 
ermanently secured, without possibilities to unlocking. To break through this security only On-
oa r 

suc

ced in EEPROM1 area in address $0800. If valu
p
B rd programming interface and Auto SS mode can be used. After HC08-Programme

cessfully finish unlocking procedure value of security EEPROM cell can be changed to $FF. 
After next power on reset device became unsecured. 

Working with EEPROM, FLASH areas not differs from work with customary devices (see 
Section 5.1). 

 
5.4 MC68HC08AZ60 1J35D MASKSET 
 
This section describes the algorithm to work with MC68HC08AZ60 device, 1J35D maskset. 

rd 
pro

Device has non standard security scheme. To break through this security only On-Boa
gramming interface and Auto SS mode can be used. After HC08-Programmer successfully 

finished User can work with EEPROM without any restrictions. Once device powered off new 
Auto SS procedure must be completed. 

Working with EEPROM area not differs from work with customary devices (see Section 5.1). 
 

5.5 MC68HC08AZ32A 1L52H MASKSET 
 

This section describes the algorithm to work with MC68HC08AZ32 device, 1L52H maskset. 
ding, programming until device secured. 

Becaus e devic curity Sequence entered. To 
find Security Sequence bytes On-Board programming and Auto SS mode must be used for first 
tim  as On-Board as well as In-Circuit. 

ee Section 5.1.5.1 for details. 

In this device EEPROM and ROM locked for rea
e th e ROM based it can be unsecured only if right Se

e. Than after right SS found, EEPROM can be read, program
S
 

5.6 MC68HC05H12 0H57A MASKSET 
 

This section describes the algorithm to work with MC68HC05H12 device, 0H57A maskset. 
EE

programmi ce is used for MC68HC05H12 device. 
Bec ulation of programming interface 

implem 8HC05H12 pins drown in Figure 2. On 
the figu
auto detect nected to device must be 4 MHz or 4.19 MHz. 
 
EEPROM located form $0400 to $04FF. 
EEPROM Options Register (EEOPR) at $0400 address. 

 

PROM reading, programming operation is available for this device. Also, In-Circuit 
ng interfa

ause of device don’t have MON08 interface, em
ented. Conformity between MON08 pins and MC6
re MON08 pins denoted by red color. HC08-Programmer has no possibilities of bus speed 

ion for the device. Ceramic resonator con

 Note: Do not use PLCC52 adaptor for this device. 
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5.6. ptions Register 1 Working with EEPROM O
 

Device ster (EEOPR) which contain EEPRT bit. This bit locks 
EPROM area from $0480 to $04FF from erasing, programming when cleared. 

 
To unlock area: 

 Read d Sequence panel push “Read EEPROM” button than “Start” 
button). 

 Save EEPROM contents to file (see Section 8.2). 
 Set EEPROM cell $0400 to $FF in Hex Editor. 
 Complete write to EEPROM (On “Program Sequence” panel push “Program 

EEPROM” button than “Start” button). 
 On next power On EEPROM area from $0480 to $04FF will be unlocked. 

 
To lock area: 

 Load or enter desired data to EEPROM Area (see Section 8.1). 
 Complete write to EEPROM (On “Program Sequence” panel push “Program 

EEPROM” button than “Start” button) 
 Set EEPROM cell $0400 to $FD in Hex Editor. 
 Complete write to EEPROM. 
 On next power On EEPROM area from $0480 to $04FF will be locked for 

programming. 
 

 has EEPROM Options Regi
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40

468
7

1

14

21

47

3420 33

VREFH
AVDD

VDD

PB3
PB2
PB1
PB0
PA7

PA4
PA3

PA2

3/
A

N
3

2/
A

N
2

1/
A

N
1

0/
A

N
0

S
E

T

PC0/TCAP0
PC1/TCAP1
PC2/TCAP2
PC3/TCAP3

PA6
PA5

PC4/TCMP0

PC5/TCMP1
PC6/RDI

PC7/TDO
PVDD2 PA0
PVSS2 PVDD1

PE
7

PE
6

PE
5

PE
4

PF
3

PF
2

PF
1

PF
0

PE
3

PE
2

PE
1

PE
0

PV
S

S
1

PA1

PD PD PD PDVS
S

R
E

O
S

O
S

IR
QC

1
C

2 /V
PP

/S
C

K
/M

O
SI

/M
IS

O

MC68HC(7)05H12

PB0 PTA0

HIGH1
PTC0

VDD

V
SS

S
E

T
R

E
SE

T
R

E
SE

T

IR
Q

PB
7

PB
6

PB
5

PB
4

R
E

(52-pin PLCC package)

 
Figure 2. MC68HC05H12 pin assignments 
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6. EEPROM STRUCTURE 
 
All Motorola devices 08 family has same EEPROM structure shortly described below. 
 

6.1 EEPROM BLOCK 1 
 
EEPROM1 - 512 bytes located from $0800 to $09FF. 

ENVR1 - Nonvolatile Register (Block Protect Options and EEPROM1, 2 Security)* 
 some devices see Table 5) 

resent on some devices see Table 5) 

Ext

 Programming and erasing of secured locations $08F0 to $08FF is permanently disabled. 

, 

 
Extr

Once EEDIVSECD in the EE1DIVH is programmed to 0 and after a system reset, the E1DIV 

E
EE1DIVH - Nonvolatile Divider Register High* (Not present on
EE1DIVL - Nonvolatile Divider Register Low* (Not p
 
ra care must be taken when programming EEPRTCT bit (4 bit) in EENVR1. 
Once the EEPRTCT bit is programmed to 0 for the first time: 

 Programming and erasing of EE1NVR is permanently disabled. 
 Bulk and Block Erase operations are disabled for the unprotected locations $0800-$08EF

$0900-$09FF. 

a care must be taken when programming EEDIVSECD bit (7 bit) in EE1DIVH. 

security feature is permanently enabled because the EEDIVSECD bit in the EE1DIVH is 
always loaded with 0 thereafter. Once this security feature is armed, erase and program 
moderate disabled for EE1DIVH and EE1DIVL. Modifications to the EE1DIVH and 
EE1DIVL registers are also disabled. 
 

6.2 EEPROM BLOCK 2 
 
Thi PROM
EE M2 - 5
EE VR2 - No y)* 
EE2DIVH - Nonvolatile Divider Register High* (Not present on some devices see Table 5) 
EE2DIVL - Nonvol ile Divider R te w* ot pre nt on e devices see Table 5) 
 

Extra care must be taken when prog m  E TC it (4 ) in VR
Once the EEPRTCT bit is programmed to 0 for the first time: 

 anently disabled. 
 g of E N  i n i bl d. 
 erati  ar is p ot ted lo tio s 60 -$ 6EF, 

 
Extra care must be taken when prog m  E S t 2

Once DIV is gr  d t IV 
secu ly e le  bec e IV e EE2DIVH is 
alwa after. ce is t r is armed, erase and program 
mod 2DIVH n EE . Modif ations to the EE2D H and 
EE2 isable
 

scrip n of s bits signm nt ca be 
downloaded f

 

s EE  area not present on some devices (see Table 5). 
PRO 12 bytes located from $0600 to $07FF. 

nvolatile Register (Block Protect Options and EEPROM1, 2 SecuritN

at egis

ram

r Lo

ing

 (N

EPR

se

T b

 som

 bit EEN 2. 

Programming and erasing of secured locations
Programming and eras

 $06F0 to $06FF is perm
s permain

Bulk and Block Erase o
E2 VR ently d sa e

ecp
$0700-$07FF. 

ons e d abled for the un r ca n $0 0 0

ram ing EDIV ECD bit (7 bi
 after a

) in EE
 system

DIVH
 reset, 

. 
 EEDIVSECD in the EE2 H  

d
pro ammed to 0 an he E1D

rity feature is perman nte
ys loaded with 0 the

nab ause th  EED
y featu

SECD bit in th
re

erate disabled for EE
On  th  securi e  
 a d 2DIVL  ic  IV

DIVL registers are also d d. 

 Note: Full de tio register  as e n 
rom http://www.etlweb.net/ in “Documents” section. 
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Device E
E

PR
O

M
1

E
E

PR
O

M
2

E
E

N
V

R
1

E
E

N
V

R
2

E
E

1D
I

E
E

1D
I

E
E

2D
I

E
E

2D
I

    

V
H

 

V
L

 

V
H

 

V
L

 

MC68HC908AZ60 (2J74Y)   $FE1C $FE18     
MC68HC908AZ60 (4J74Y)   $FE1C $FE18     
XC68HC908AZ60 (8H62A)   $FE1C $FE18     
M 08AZ60A(3K85K)   $FE1C $FE7C $FE10 $FE11 $FF70 C68HC9 $FF71 
MC68HC9    08AS60 (3J74Y)   $FE1C $FE18  
MC68HC908AS60A (1L87J)   $FE1C $FE7C $FE10 $FE11 $FF70 $FF71 
MC68HC908AB32 (3K56G)   $FE1C  $FE10 $FE11   
MC68HC08AZ60 (1J35D)   1C $F     $FE E18 
MC68HC08AZ32 (0J66D)   E      $F 1C 
MC68HC08AZ32 (1H   E      56A) $F 1C 
MC68HC08   $FE1C      AS20 (0H94K)   
MC68HC0  E1C  $ $F   8AZ32A (1L52H)  $F  FE10 E11 
MC68HC0  E1C      8AB16A (0L72A)  $F  

Table 5. 08 fam EP O c
 

ily E R M stru ture 

7. FLASH STRUCTURE 
 

This section s e of the em edded FLASH memory. FLASH area 
physically divided into separate blocks. These blocks  b  protec d from erase, write operations 
with help of FLA rs: 
FLASH-1 Block Protect 
FLASH-2 Block P ) – No  pre t n some CU ( e Table 6). 
There are no restr  any F AS ar a.  

 Note: Full loaded from 
eb.net/ in “Documents” section. 

 

hortly describes the structur b
can e te  

SH Block Protect Registe
Register (FL1BPR) 

rotect Register (FL2BPR t sen o  M se
ictions of programming of L H e

description of FLASH memory can be down
http://www.etlw

 

Device R
O

FL
A

SH
 

M
 

FL
1B

PR
 

FL
2B

PR
 

E
R

A
SE

 
ST

A
T

E
 

MC68HC908AZ60 (2J74Y)   $FF80 $FF81 $00 
MC68HC908AZ60 (4J74Y)   $FF80 $FF81 $00 
XC68HC908AZ60 (8H62A)   $FF80 $FF81 $00 
MC68HC908AZ60A(3K85K)   $FF80 $FF81 $FF 
MC68HC908AS60 (3J74Y)   $FF80 $FF81 $00 
MC68HC908AS60 (1L87J)   $FF80 $FF81 $FF 

   $FF7E  $FF MC68HC908AB32 (3K56G)
MC68HC08AZ60 (1J35D)      

32 (0J66D)     MC68HC08AZ  
MC68HC08AZ32 (1H56A)      
MC68HC08AS20 (0H94K)      
MC68HC08AZ32A (1L52H)      
MC68HC08AB16A (0L72A)      

Table 6. 08 family FLASH/ROM structure 
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8. FILE OPERATIONS 
 
T  working with files. Memory dump from Hex Editor 

(Buff  hard disk. Also short descriptions such as project name, MCU 
type 08-Programmer accepts 
tree t

 format) 

his section describes basic rules of
er) can be load/save from/to
and memory cell assignment can be done for future fast remind. HC
ypes of file formats:  

 BIN (Binary format) 
 S-Record (Motorola S19, S20 Records
 EEF (Extended ETL Format) 

 
8.1 LOAD FILE INTO BUFFER 
 

 Select “File>Open” menu item. 
 Press “Browse” button. 
 In File Open Dialog window, select file witch need to be open.  

d:” text, select correct file format. Note that software 
try automatically detects file format, but unknown records in file will fail this detection. 

 must be checked if automatically loading procedures 

S uffer allocations required. For Example if required 
load  from binary file beginning from $0000 address follow next steps: 

on. 

 Press “O
 Than, op inary format. 
 Uncheck “Load Entire File” check box. 

enter 0x0400. 
 Than press “OK” button. 

 required, for example load Hex Editor Buffer from 
ma
“Clear Buffer Be

 Press “Open” button. 
 Than opposite “Auto Format Detecte

“Load Entire file” check box
required. 

 Than press “OK” button. 
ometimes load data from file to specific b
buffer from $0400 address

 Select “File>Open” menu item. 
 Press “Browse” butt
 In File Open Dialog window, select file which need to be open. 

pen” button. 
posite “Auto Format Detected:” select B

 In field “Offset Value to Place Data to Buffer:” 

 Now data placed to Hex Editor Buffer from the beginning of 0x0400 address. 
 
If more complicated operations with files

ny files “Lowest Address From File To Load”, “Highest Address From File To Load” and 
fore Loading File” options are available. 

 
8.2 SAVE FILE FROM BUFFER 
 

 Select “File>Save” menu item. 
Browse” button.  Press “

 Type fi

 e EEF Format for future “Load File Into Buffer” automatically 

 

 Select directory in which file will be saved. 
le name, for example “test1” 

 Press “Save” button. 
 Than select format in which file will be saved*. 
 Press “OK” button. 

Note: Us
processing. Also, only in EEF Format Project Description, Device Name and 
Memory Cells attributes can be saved. 
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9. ERRORS AND TROUBLESHOOTING 
 

 

 Causes: This 
Progr

 Solutions: Check voltage on HC08-Programmer power clamps. It must be 12 V +/- 1V. 

 LED
his rnal power supply voltage or voltage on IRQ 

 Solutions: Remove any adaptors from Motorola device socket. Check voltage on HC08-
 must be 12 V +/- 1V. 

 Problem: LED
 Causes: This problem can accrue when logical levels on PTC0, PTC1, PTC3 pins not 

orre gulator 
damaged. 

on at
need ents. If after relishing PTC0, PTC1, 

TC3 n. 

r no oscillation on OSC1, OSC2 pins. 
elatively to VSS pin, and if it too low 

checks passive, active components connected. Or check integrity of ceramic 

 Error Message:  be in 'High' state" 

 Solutions: ponent from pin. 

, PTC3 pins and voltage on IRQ pin not correspond to MON08 

 Solutions: uirements according Appendix Figure 3. 

 Error Message: 
 Causes: essage can appear when MCU IRQ pin connected to ground thru 

 

This section describes most recently encountered problems, errors and fixing solutions. 

 Problem: LED1 (see Figure 1) Dark. 
problem can accrue when external power supply connected to HC08-
ammer broken or connected in wrong polarity. 

 
 Problem: 1 (see Figure 1) Red. 

problem can accrue wh Causes: T en exte
pin (2 pin Motorola device socket) lower than 9.5 Volt. 

Programmer power clamps. It
 

3 on HC08-Programmer still Green when LED1 became Orange. 

c spond to MON08 monitor requirements or if Built-in Voltage Re

 Solutions: Disconnect PTC0, PTC1, PTC3 pins from target board. If LED3 appears Orange 
tempting to Link Device, connect pin by pin to MCU to find out which pin 
to be released from external compon

P  pins LED3 not Orange, possible Voltage Regulator is broke
 

 Error Message: "Reset line must be in 'High' state" 
 Causes: This message can appear when MCU Reset pin connected to ground thru 

external components o
 Solutions: Check MCU reset pin resistance r

resonator and passive components connected to OSC1, OSC2 pins. 
 

"PTA0 line must
 Causes: This message can appear when MCU PTA0 pin connected to ground thru 

external components. 
Cut any com

 
 Error Message: "No Echo from MCU" 
 Causes: This message can appear when target MCU not connected; logical levels on 

PTC0, PTC1
monitor requirements. 
Check MON08 monitor req

 
 Error Message: “Wrong Echo from MCU" 
 Causes: This message can appear when wrong Device selected. Communication 

speed not corresponds to this device. 
Select correct device type; take attention on MCU maskset.  Solutions: 

 
"IRQ line must be in 'High' state" 
This m
external components. 

 Solutions: Cut any component from IRQ pin. 
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 Error Me "Communication Error" 
This message can appear when Communication b

ssage: 
 Causes: etween HC08-Programmer 

 Solutions: 
ssage can appear when COM port cable has poor contact with DB-9 

 
 Error Messa
 Causes: CU 

 Solutions: Try to reconnect to target MCU. If this error not disappeared, possible target 
MCU has damaged RAM. 

 Error Message: "NO response from MCU, possible RAM, RxD or TxD pins damaged" 
U 

 out error“ encored. Also additional pins (RxD, 

 reconnect with 
target MCU. If this error not disappeared, possible target MCU has damaged 
RAM. 

 
 Error Message: "NO response from MCU, possible RAM damaged" 
 Causes: This message appeared at the same conditions as described above with the 

exception of only PTA0 pin used for echo reply. 
 Solutions: Trace contact form PTA0 pin to pins on adaptor. Try to reconnect to target 

MCU. If this error not disappeared, possible target MCU has damaged 
RAM. 

 Note: HC08-Programmer has Log Window which can be stored to file. To 
perform this operation right clicks on Log Window. Than click on “Save to 
HC08Programmer.log file“menu item. Now this file can be found in the sane 
directory as HC08-Programmer software. Log File can be send by E-mail to 
techsupport@etlweb.net for non described problem solution. 

 
 

 
 

ETL warrants that Product delivered shall conform to applicable. Report any defects for a 45 
days period, from the applicable data on invoice. 

All ETL's product are intended for lawful service, repair or replacement of various electronic 
equipment with the laws of the country in which the product is being sold or used. 

and PC broken. 
Try to decrease baud rate in “Tools>Ports Options” dialog window. Also 
this me
connectors. 

ge: "Monitor firmware Check Sum Error" 
This message can appear after monitor firmware loaded into target M
with errors. 

 

 Causes: This message can appear after monitor firmware loaded into target MC
and “waiting for echo time
TxD) used for On-Board programming disconnected or damaged. 

 Solutions: Trace contact form RxD, TxD pins to pins on adaptor. Try to

10. WARRANTY STATEMENT AND DISCLAIMER 
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 11. APPENDIX 
 

M68HC08
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VSSA
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VDDA

VDD

Gnd

PTC0
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OSC2
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External Clock*

Logic level on this pin must be “LOW”

908AZ60
programmer
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RESET

IRQ
VCC

CNT2

PTC1
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PTC0

OSC1
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3

5

Logic level on this pin must be “LOW”

Logic level on this pin must be “HIGH”

 
 

Figure 3. MON08 Circuit 

Note: If crystal resonator frequency smaller than 1.6 MHz use External Clock
from CNT2 connector. Any component on OSC1, OS

  
C2 such as capacitors, 

resistors and crystal resonator must be disconnected. 
 

 
 

IR
Q

 

R
ST

 

PT
A

0 

PT
C

0 

PT
C

1 

PT
C

3 

V
ss

 

V
ss

a 

V
dd

 

V
dd

a 

O
SC

1 

O
SC

2 

QFP64 3 2 26 60 61 63 21 56 22 55 59 58 
QFP100 3 2 44 96 97 99 30 92 31 91 95 94 
PLCC52 1  3 2 0 9 27 4 5 7 25 52 26 51

Table 7. Pin assignments for various packages 
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Figure 4. In-Circuit wiring diagram for 68HC(9)08AZxx Series MCU, QFP 64 Package 

©ETL 2002-2005 MC68HC908AZ60 Programmer Serial Port Version User’s Guide 20 



PTF4

C
G

M
XF

C

PTB7/ATD7

PTF3/TACH5

PTF2/TACH4

PTF1/TACH3

PTF0/TACH2

RST

IRQ

PTC4

BDRxD

BDTxD

PTF5

PTE0/TxD

PTE1/RxD

PTE2/TACH0

PTE3/TACH1

PTH0/KBD3 

PTD3/ATD11 

PTD2/ATD10

AVSS /VREFL

VDDAREF

PTD1/ATD9

PTD0/ATD8

PTB6/ATD6

PTB5/ATD5

PTB4/ATD4

PTB3/ATD3

PTB2/ATD2

PTB1/ATD1

PTB0/ATD0

PTA7

V
SS

A

V
DD

A

V
RE

FH

PT
D

7 

PT
D

6/
AT

D
14

/T
AC

LK

PT
D

5/
AT

D
13

 

PT
D

4/
AT

D
12

PT
H

1/
K

BD
4

PT
C

5

PT
C

3

PT
C

2/
M

C
LK

PT
C

1

PT
C

0

O
S

C
1

O
S

C
2

PT
E

6/
M

O
S

I

PT
E

4/
SS

PT
E

5/
M

IS
O

PT
E7

/S
P

SC
K

V
SS

V
DD

P
TG

0/
K

BD
0

P
TG

1/
K

BD
1

P
TG

2/
K

BD
2

PT
A

0

PT
A

1

PT
A

2

PT
A

3

PT
A

4

PT
A

5

PT
A

6

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18 19 20 21 22 23 24 25 26 27 28 29 30 31

32

47

46

45

44

43

42

41

40

39

38

37

36

35

34

33

64

63 62 61 60 59 58 57 56 55 54 53 52 51 50

PTF6

48

49

MC68HC(9)08AS60A
MC68HC(9)08AS60
MC68HC(9)08AS20A
MC68HC(9)08AS20

64 QFP

P
TC

3

P
TC

1

PT
C

0

P
TA

0

V
C

C

G
N

D

IRQ

RES

 

Figure 5. In-Circuit wiring diagram for 68HC(9)08ASxx Series MCU, QFP 64 Package 
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Figure 6. In-Circuit wiring diagram for 68HC(9)08ASxx Series MCU, PLCC 52 Package 
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Figure 7. In-Circuit wiring diagram for 68HC(9)08ABxx Series MCU, QFP 64 Package 
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Figure 8.In-Circuit wiring diagram for 68HC08AZ32 MCU, LQFP 100 Package 
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Figure 9.In-Circuit wiring diagram for 68HC(7)05H12 MCU, PLCC 52  Package 
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